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Welcome to a new semester of being a T.A. for the Chemistry Department.  The compiled
information will assist you with questions that you may have.

For more useful information, please see:
www.cm.utexas.edu/graduate/gradhints.html
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CHEMISTRY UNDERGRADUATE COURSE OFFICE,
WELCH 2.212 CONTACT INFORMATION & SERVICES

This office is generally closed for office staff meeting on Mondays from 8:00 to 9:00
am.  During this time you are welcome to access the office but we will be unable to
answer your questions.

Contact Information

o Shari Mallory              Email:  smallory@mail.utexas.edu
o Sandra Godfrey Email:  sandy@mail.utexas.edu
o Greg Browning           Email:  g.browning@mail.utexas.edu

      Welch 2.212     -        (512) 471-4983 or  (512) 471-1567
Office is open  7:30 AM – 5 PM

General Information

• Supplies are kept in Welch 2.212  (file cabinet closest to scanner room)
o Paper
o Pens/Pencils
o Dry Board Markers/Erasers
o Need something else?  (Request other class supplies through Shari

Mallory)
• A telephone is available in copier room.
• Two computers are available for use, one in the scanner room and one in the

copier room.  (People needing to use the scanner have first priority for the scanner
room computer.)  On the computer desktop please set up a folder for your class
labeled with professor’s name and semester.

• Mailboxes provided for each class for use by Professor and T.A.  These are
located near the copier.

• Course textbooks can be checked out from office staff.  (These   must be checked
in at the end of the semester.)
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Office Hour Rooms and Room Reservations
• T.A. office hours are generally held in cubicles in the Welch 1.300 hallway.
• Sign up for your office hours on the forms on a clipboard in Welch 2.212.

These are located on the bar in front of Sandra’s desk.  Please use only pencil!
• Reserving other rooms for office hours or review sessions:

o Most rooms are reserved through Room Scheduling.  We will reserve
these rooms for you.  Please fill out the form on the clipboard on the
bar in front of Sandra’s desk and allow 24 hours for room reservation.

o Some other departmental rooms are available and may be reserved
through the Chairman’s Office.

 Downloading and Printing Class Rosters
The information in this section has been copied from the UT website for your convenience.

Authorization

Before a TA can download a course roster, the instructor for the course must
authorize them to do so.  You will need to provide the professor with your EID.

If you are the instructor of record of a class, you may use Add/Remove TA to
authorize substitutes for downloading class rosters.

At the (class roster download homepage):
1. Click on the 'Add/Remove TA' link under Request Forms in the left navigation
     bar.
2. At the CLIPs Menu page, click the unique number for which you would like to
    authorize the TA.
3. At the next page, click the 'authorize assistants' link located in the left
    navigation bar under Instructor Info.
4. Enter the UT EID of your TA, ensure that the CLIPs box is selected, and click
    the 'Update Authorization' button.
5. Repeat steps 2 through 4 for each TA you would like to authorize.
    Administrative staff may not add or remove TAs. The TA's ability to download
    class rosters expires at the end of each semester.

Printing Photo Class Rosters
 The three keys to successfully printing photo rosters are:
1. Minimize page margins,
2. Choose landscape page orientation, and
3. Delete page headers and footers.

Though your computer setup and procedures may differ slightly, it may be
instructive for you to see how these steps are accomplished in our office:
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PC
Internet Explorer 6 or newer
_To minimize page margins, select Page Setup from the File menu, and delete
the numbers in the top, bottom, left, and right margin boxes.
_To select landscape orientation, type Ctrl-P to print, click the Layout tab, select
Landscape, then click the Apply button.
_To delete page headers and footers, select Page Setup from the File menu, and
delete everything from the Header and Footer boxes.

PC
Netscape Navigator 7.02 or newer
_To minimize page margins, select Page Setup from the File menu, click the
Margins and Header/Footer tab and delete the numbers in the top, bottom, left,
and right margin boxes.
_To select landscape orientation, type Ctrl-P to print, click on the Properties
button, and select Landscape.
_To delete page headers and footers, select Page Setup from the File menu, click
the Margins and Header/Footer tab and change all header/footer settings to
Blank.

Mac
Internet Explorer 5.0 or newer
_You cannot minimize page margins. Instead, type Command-P to print, select
Internet Explorer from the General drop down menu, and ensure that Print
Images and Shrink Pages to Fit are selected.
_To select landscape orientation, select Page Setup from the File menu and click
the Landscape button.
_To delete page headers and footers, select Print from the File menu, select
Internet Explorer from the General drop down menu, and ensure that Headers
and Footers is deselected.

Mac
Netscape Navigator 7.02 or newer
_You cannot minimize page margins. Instead, select Print Preview from the File
menu, select Shrink to fit from the Scale pulldown menu.
_To select landscape orientation, select Print Preview from the File menu and
click the Landscape button.
_You cannot control page headers and footers.
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Using the Natural Sciences On-Line Homework System

Setting up a homework server account:
• Go to hw.utexas.edu/hw.html, click “OK”.
• For “departmental phone number” use the undergraduate office number, 471-1567.
• The “instructor’s instructions”, accessible through button 5.2 “view documentation” are

brief and helpful.
• To log onto your account once created, use the URL hw.utexas.edu/fm
• First thing you are forced to do:  button 2.7 “set up or modify grading”.  This is easily

changed later, so if you are unsure of the exact number of assignments, you can put
something in now and fix it later.  Note:  Most people choose “do NOT use negative
points on bubble sheet assignment” but this is not the default setting – unless you want to
penalize wrong answer with negative points, you will have to click the correct box when
setting up your grading.

Getting students signed up:
• This is discussed in the instructor’s instructions (button 5.2).
• It is good to encourage students to read the student instructions, especially the parts on

how to enter numerical answers and on the positive/negative scoring system.  If you are
not using negative points for bubble-sheet assignments (quizzes and exams) make sure to
let them know this prior to the first bubble sheet assignment.

• Options for 10-digit student ID numbers used on the homework server:
o Allow them to make up their own number.  Suggesting they use a 10-digit phone

number works well.
 Advantages:  Easy to remember, unless they forget which phone number

they used.
 Disadvantages:  This number will not be on their ID card, so they could

theoretically fill out a scantron for someone else since your cannot verify
their ID number.

                  _     Have them use the number on their ID card – the last 10 numbers of the 16 digit
number.  (It is printed with 6 digits, a space, and then the unique 10-digit ID
number.

                       Advantages:   You can verify the ID # they bubbled in matches the one on
their ID card.

                    _   Disadvantages:   This number will change if they get a new ID card.  If
this happens UNDER NO CIRCUMSTANCES should they change their
ID number in the homework server.  Changing their ID number can cause
many of their previous quiz and exam grades to disappear.  Right after they
sign up for the homework server, encourage them to write this ID number
in their course notes, on the back of your calculator, or somewhere else
where they will have access to it during each class.  If they get a new ID
card, they should still use their old ID number on the scantrons.  It is good
to explain this to them, as many students will not realize the new card has a
different number and will just start using that new number, causing
bubbling errors.
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Purging and locking the roster (after the first homework assignment)
• It is a good idea after the first homework assignment or two (sometime after the twelfth

class day) to purge the homework server roster. (This keeps students from setting up two
accounts – one to figure out the correct answers and one their real name to enter the
correct answers for a grade.)  To do this, download your official course roster (link from
registrar’s page: http://www.utexas.edu/student/registrar/) and download a list of all
students signed up on your homework server account using button 3.4.  Compare the two
and use button 3.7 to delete any students not on the official course roster.  Note that you
can undelete students using button 3.8 if you make a mistake.

• Once you have purged the roster, use button 3.9 to lock enrollment – no more students
can add themselves to your course.

• You can use button 3.6 to add student to your class once enrollment is locked.

Finding problems for use on assignments
• We will print each professor a copy of the homework server books applicable to their

class prior to the beginning of the semester. When you are through with these books,
please drop them into the container in the undergraduate office for shredding. There is
also a reference copy of each book kept for use in the undergraduate office.  Additionally,
you view all of the homework service books in pdf format using button 5.2.

• Problems are categorized:
o Wording-variable:  different problems have randomized changes.  For example,

one student’s version might ask him to identify the formula for aluminum oxide
and another student would be asked to identify the formula for magnesium
chloride.  After creating the assignment, it is a good idea to check several
versions to make sure all versions are error-free and fair for your students. (Use
the “print assignment” button to print different versions of assignments.)

o Normal: all versions of these problems are essentially identical but the numbers
will change for each student.  (One student may be asked to find the number of
moles in 5 g of NaCl and another would be asked about the moles in 8 g NaCl.)

o Fixed: all versions of these problems are identical.
• Numerical questions (ones that require a student to enter an actual answer rather than

choosing one of a selection of possible answers) can be used on bubble sheet
assignments.  On the preview version created during the process of creating the
assignment, the question will still show up without answer choices.  Once the assignment
is posted, the system will create 10 possible answer choices for the student to choose
from.  Due to the method the system uses to create these answer choices, a few numerical
problems cannot be converted to multiple-choice.  If you happen to choose one of these
problems for a bubble sheet assignment, you will be informed that it will not work during
the create assignment sequence and you will need to choose an alternate problem.

Creating an Assignment – Preview and Post
If you want to create and proof the assignment and then post it at a later time, make sure to click
through until the last page (which you can post from) before you leave the “create assignment”
sequence or log off the system.  Once you do this, the question numbers will be saved and will
still be present when you log back on at a later time.  The points per problem will NOT be saved
and must be entered right before posting the assignment.
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Button 1.1 Create an Assignment
Page 1: Select the assignment to create, choose “type problem names”
Page 2: Enter the problem names, one per line.  A blank space will be read by the computer

as a space or an underscore, so you do not need to type the underscores.
        Possible problems you may encounter after you enter these:

• Numerical problems that are not convertible to multiple-choice: You will just
have to choose a new problem.

• Problems that do not exist in the database.  One of several things can account
for this:

 You mistyped the name.  They are case-sensitive
 The problem has really been deleted.
 The problem was deleted because it was a duplicate of another database

problem.  You can find the new problem name by going to the URL
https://hw.utexas.edu/bur/mergedDups.html. This list can be sorted using
the buttons at the top of each column.

 The problem was renamed.  You can check this using the “map of
renamed problems” under button 5.2.

Page 3: Blank
Page 4: Blank
Page 5:

          _   Select the Due date:
_  For homework assignments, choose the correct due date and time for the
   assignment

                     _  For bubble-sheet assignments: To ensure they don’t get the answers ahead of
     time select and so you get a chance to look at the scores and statistics before the
     students can see them, it is often a good idea to choose a day in the future –
     perhaps Dec 31 of this year.  You will just want to make sure to change this to
     the actual due time when you are ready for the students to see the results.

         _   Type a preamble.  Any announcements you would like to appear on the first page.
         _   Choose any cover sheet you would like included.  It is usually not necessary to provide a
              periodic table with the printout since there is one on the back of the scantrons.
         _   Select a preview format and version.  (Usually instructor format. Version 1 is the default,

but often good to preview a different version to catch mistakes in wording variable
problems.)

         _   For homework assignment, you can specify the order of problems if desired.
Page 6:

         _   Print a preview version and work through everything to make sure everything is all right.
              Don’t just glance over the explanations to verify it is worked correctly – the explanations
              are new and often have mistakes.
         _   Set the points.
         _   Select the day of the week for the due date.
         _   POST the assignment. After an assignment has been posted only the due date and points
               can be changed – you cannot fix a mistake in a problem or add new problems to the
               assignment.



9

What to do if you find a problem with a mistake
You have two main options:

• If the mistake is something vital to the problem (for example, a problem with no correct
answer), you should report the problem as dysfunctional using button 4.4.  This
immediately removes the problem from use for all instructors, so be very sure about this
before you report the problem.  If you would really like to use the problem, you can email
Patsy McDonald (patsymc@physics.utexas.edu) and she may be able to fix it for you
quickly.

• If the problem can be used but has an error that should be fixed (formatting, incorrect
explanation, etc.) don’t report it as dysfunctional, but email Patsy McDonald
(patsymc@physics.utexas.edu) about the error.

What to do if you or your professor would like to write your own problems
Email the problems to Patsy McDonald (patsymc@physics.utexas.edu).  It is good to give her at
least a week to work on these, but she can sometimes get them done more quickly if needed.  An
explanation is not required to enter the problem, but Patsy would appreciate it if you would
include one.  Make sure to provide her with a name for the problem (preferably something that
indicates the problem topic: “Stoic 001”, “Molarity 002”), and which chapter/section of the
database they should place the problem in. (Note that database chapter/section numbers will be
different from the textbook chapter/section numbers.  The front of each database problem book
lists the database table of contents.) The students entering the problems are generally computer
science students, not chemistry students, so make sure the problems you send don't depend on
them interpreting what you want added - make them very clear. Once they are entered, make sure
to proof the questions carefully.

Creating an assignment with questions NOT in the database
If your professor wants to make up your own single-version quiz without the hassle of
entering new problems but would like to be able to grade it with the homework server
system:

• Create an assignment using button 1.1 and entering the appropriate number of blank
“dummy” questions.  You can use the same question more than once if needed.

• Questions with 5 answer choices:  Sparks quiz a, Sparks quiz b, … Sparks quiz e
• Questions with 10 answer choices: Sparks 10blank 001, Sparks 10blank 002,

…Sparks 10blank 005
• Post the assignment, choose a version, and print a copy of the answer key using

button 1.2.
• Write your quiz, making sure to put the appropriate version number at the top and to

put the correct answer in the space the computer thinks is the correct answer for that
question (according to your printout of the dummy questions for that version).

• You may want to post a copy of your quiz on the webpage since all students will see
on the homework server when they check the answer key will be blank questions.
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Printing Assignments
Button 1.2 Print an Assignment

Page 1: Select the assignment to be printed.
Page 2: Select the version numbers to be printed.  The printer server programs can only

handle up to a certain size file, so you will have to print this in batches of about 75-100
copies per batch.  (First do 101 to 200 and then do 201 to 300, etc.)  Select postscript
format and ‘all questions.’

Page 3: Select Postscript.  Save the file to a disk or computer.  Rename it something better
than what is given.  (Ex: Sparks304kE1_1of4.ps)  Do this for every batch of version
numbers that you have.

Upload the files to the printer server.  (Really a physics computer that puts in all the special
commands to staple each test appropriately.)

• Go to http://hwpr1.ph.utexas.edu/
• Pick "Stapled (Exams or Homework)" choice listed under chemistry
• You'll be prompted for a login name and password.  Get these from the

                    course professor.  If your professor does not have an account they should contact
                    Paul McCord (pmccord@mail.utexas.edu).  For emergency printing needs in the
                    meantime see Greg Browning in the Undergraduate Course Office.

• Click "browse" and locate your postscript file on your computer or disk.
• Click "print"
• File will start uploading
• Halfway during the upload you'll be prompted again for the name and
• password.  Enter them again and continue
• Once it uploads you will get a new screen stating such and can then upload

              the rest of the files and quit.

Verify that the files uploaded successfully.
• Go back to the page you started at (http://hwpr1.ph.utexas.edu) and click to view contents

of the printer queues.
• You should see your files in the queue.  They will be taken off as they are printed.
• Email Irene Castillo Alonzo (irene.c.a@mail.utexas.edu) in central duplicating with the

following information:
1. What you have sent: number of files and their names.
2. Number of copies printed.  (For example: We need only one copy of each file

printed. This equals ~438 individual multipage exams total.)
3. Date and time they are needed.
4. Delivery address (Wel 2.212)
5. Your contact information – phone and email.

• Irene’s phone number is 471-1615 in case you need to check on your files or have
problems.

Grading assignments and fixing bubbling errors
1. Scan the bubble sheets using the scanner and scanning software in the undergraduate office.  (If

you receive a scantron late, you can manually add the students answer later using button 2.12.)
Talk to Greg Browning in the Undergraduate Course Office for instructions on using the
scanner.

2. Use button 4.5 to upload the bubble sheet file.
3. Use button 2.1 to grade the assignment.
4. Use button 2.11 to view statistical plots.  The “X” file will show the overall average and the

“q” file will show the “by question” statistics.  This file can be useful to identify any possible
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grading or answer key problems.  (The questions are number by the order they appear on
version 1.  You can find the question name associated with each number using button 1.12 –
“map between problem names and question numbers.”)

5. Use button 2.17 (cheating control) to identify any two or more students with the same version
number.  If you printed these through University Duplicating with the methods listed here, you
should not have duplicate version numbers.  If more than one student bubbles the same version
number, you can ask both to bring you their original copy of the exam so you can figure out
who had the real copy.  Usually these are bubbling errors but every semester there is at least
one student who tries to cheat this way.

6. Use button 2.15 to find bubble sheet errors (misbubbling of version number or ID number).  It
is easiest to print these before you go to the “fix bubble errors” page.

7. Use button 2.12 to fix bubble sheet errors.
8. Download the student grades spreadsheet and save on a secure disk or computer after each

major assignment as back-up in case of system failure

What to do if you find a mistake in the answer key or problem AFTER grading
Aside from correcting grades on a student-by-student basis, the main two options are to kill the
problem (make it worth zero points) using button 1.6 or to give all students 100% credit for that
problem using button 2.6.

Other Useful Homework Server Functions
Button 1.12: Map between problem names and question numbers
Button 2.3: Semester grades, one student.  Shows all grades for the semester for that student.

Depending on your course’s grading scheme, the overall grades shown at the bottom
of the page may or may not be correct.

Button 2.5: Assignment grades, one student.  You can use this to see what the scanner read for
each question for that student and what the right answer was for that question.

Button 3.3: Get info one student.  Use this to find email addresses, UT EID, etc.
Button 3.12: Post emergency bulletin to your students.  This allows you to post a message that

will appear on the first screen they see when they log onto the system.

Downloading and Submitting grades
• Use button 2.2 to download grades in spreadsheet format.
• Use button 3.4 to download student information in spreadsheet format.
• You can use cut-and-paste or the vlookup function in Excel to match the EID to the

correct student name/ID number.  This EID is needed in the spreadsheet to submit the
grades electronically via spreadsheet.
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EXAMS

Preparing for the exam day
Before the exam (and preferably the day before, not just the hour before in case of any problems
you might discover):

• Check that the appropriate number of test copies have arrived.  Your professor may
appreciate an email to let him/her know that the tests have arrived.

• Prepare the exams in one box per exam room, and label accordingly.  Things typically
included in each box:

o “Exam in Progress.  Do not enter until this sign is removed” signs for each door
to each room.  (4 for Welch 2.224, 2 for Wel 1.308, you will need to check on the
others.)

o “No ID” sheet
o Exams (make sure to have the right number in each box and label which box

goes to which room.)
o Scantrons
o A few extra pencils.
o Scratch Paper (If approved by the Professor)
o Extra calculators if your professor likes to provide these.  These must be checked

out from Greg in the Undergraduate Course Office.

During the exam
• Proctors: You will likely have other TA proctors to help proctor the exam as well as

undergraduate proctors.   During the exam either you or the professor, is in charge of
these proctors.  Don’t hesitate to ask them to help you or give them specific tasks.  They
should be up, moving around, helping monitor the classroom.  Please let the
undergraduate course office know if you have any concerns about the proctors or if you
feel you need more or less proctors to adequately cover the exam.

• If you suspect cheating:
o Collect any evidence (cheat sheets, programmable calculator with notes in it, etc.)

You do have the right to keep this evidence while the case is being made with
Student Judicial Services.  Additionally, the screen of a programmable calculator can
be copied on a Xerox machine.

o If you believe the student is looking off another student’s paper, feel free to politely
ask the student to move to a new seat.  Alternately, you can get someone else to
watch too, and then ask the student to move to a new seat.  If you are certain they are
cheating, get both students names so you can compare their scantrons later.

o In any case, you MUST let the student finish the exam!

Procedure for Make-up, Extended Time and other Exams:
• Leave the exam to be given in the “To Be Taken” blue file in file cabinet near  Scanner

Room..
             _   Fill out the “Early Exam Information Sheet” (orange form) provided by the

Undergraduate Course Office and attach to front of the exam.  Makes sure that all
relevant information is included.  (Examples:  date, length of time given, type of
exam, instructions saying they can take or if they should leave the exam copy, and if
scratch paper is allowed.

             _  Please fill out “Make Up Exam T.A./Professor” contact form each time
                  exams are to be taken in our office.
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_    Students will be required to sign in/sign out and leave all personal items outside
      of exam room.  Students will be allowed to take in calculators, pens and
      pencils, unless you leave other instructions.
• If there will be more than 2 students at one time, the T.A. should inform the

Undergraduate Course Office Staff and we will reserve the Chairman’s Office conference
room to accommodate the extra students.

• After the exam has been taken the exam will be filed for the professor or T.A. in the
“Exams Completed” alphabetized folder.

After the exam (or any time you hand out an assignment or other papers)
• Please make sure someone walks around the classroom and pick up any excess copies.

These can cause confusion when students from later classes come in and think they are
handouts for their course.

• Clean up after the exam is essential
o Return carts
o Provide Shari with three copies of the exam for office files
o Empty boxes of exams, pencils, and unused scantrons and put these in their

appropriate locations.
o Gather exams from students that took exams in the Undergraduate Course

Office from file.
o If students with extra times are not finished, the T.A. can retrieve their

exam later from the drawer where they are filed.
• Procedures for storing scantrons

o After scanning a blue cover sheet (available near scanner) should be placed on
top for identifying class and exam number. Scantrons should be stored in a box in
the scanner room labeled with the professor name, course, and semester.



14

FINAL EXAM INFORMATION

This information has been copied here from the UT website for your convenience. The Office of
the Registrar schedules final exams in both university-controlled (general purpose) and
departmental classrooms at the request of the academic departments.  The complete final exam
schedule is then distributed to Custodial Services prior to the start of exam days.  Custodial
Services is responsible for unlocking university-controlled rooms as needed for finals.  It is the
responsibility of the department to arrange for unlocking departmental classrooms.  Although the
failure rate of this complicated system is very small, it is a serious problem when a locked door
prevents access to even one final exam.

 What can you do to reduce the risk of this problem?

 1.  Check your room assignments for final exams today.  Even if you already know the time and
place for your exam, please check the web site at:
<http://utdirect.utexas.edu/rgexam/getyys.WBX>
 to confirm the information. We highly recommend that you visit the room prior to exam day.  If
you have a question about your final exam room assignment, contact the course scheduler in your
department (for chemistry Undergradate Course Office staff) or the Office of the Registrar
scheduling office at 475-7600.

 2.  If you are not sure if your assigned room is departmental or university-controlled, ask your
department scheduler or check the technology classroom database at
<https://www.engr.utexas.edu/classrooms/search_form.cfm>. All university-controlled rooms are
in this database and will be noted as scheduled by the Office of the Registrar.  Custodial Services
will have keys to all university-controlled rooms.  Do not lock a university-controlled room
behind you after the exam.

 3.  If you have been assigned a departmental room and do not have a key to this room, please
discuss this with your department scheduler.  Custodians do not have keys to all departmental
rooms.   For security reasons, the department itself must arrange for some rooms to be unlocked
for final exams, and the scheduler should give you information about what to do in the event the
room is inadvertently re-locked by the previous user.

What can you do if you have a problem?

1.  Arrive at your exam room at least 30 minutes before the exam begins.  If your room is not
unlocked, contact Custodial Services at 471-5072.  If this phone is not answered, contact the
Physical Plant trouble line at 471-2020.

2.  Scheduling has established a room scheduling trouble line. This phone number, 475-7503, will
be answered by Scheduling staff during all final exam sessions and the half hour before each
session.   We will be prepared to assist you with contacts and alternative testing locations in the
event of a problem, but we do not have keys to classrooms.  This phone number will also be
answered any class day, 8:00am-12:00noon and 1:00-5:00pm.

 3.  The University Police Department will send an officer to assist you in a serious
emergency; but, depending on circumstances, unlocking a door might not be their highest
priority.  Please do not count on their immediate response.
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 4.  Record these telephone numbers:

Scheduling Trouble Line, 475-7503

Custodial Services, 471-5072

Physical Plant Trouble Line, 471-2020

University Police Dept, 471-4441

Office of the Registrar, Current Scheduling, 475-7600 (M-F, 8:30am-4:30pm)

MEDIA TRAINING FOR MULTI-MEDIA CLASSROOMS

            *URLWebsite – Instructions:
              http://www.utexas.edu/academic/cit/services/training/techclassrooms/.

*Key and password for the console to be given to T.A.’s by Undergraduate
  Course Office staff.


